# Table of Contents

1. **Introduction** .................................................................................................................. 4

2. **Setting up your PowerPoint Environment** .................................................................. 6  
   2.1 Get a maximal screen area .......................................................................................... 6  
   2.2 Start with a blank page .............................................................................................. 6  
   2.3 Choosing the appropriate size ..................................................................................... 7  
   2.4 Setting Ruler and Drawing Guides ............................................................................. 11  
   2.5 Changing the background ......................................................................................... 13  
      2.5.1 Selecting a theme ................................................................................................. 14  
      2.5.2 Another way to select a theme ............................................................................ 15  
      2.5.3 Setting the background: uniform color (solid fill) ............................................ 16  
      2.5.4 Setting the background: Gradient fill ............................................................... 16  
      2.5.5 Setting the background: Picture or texture fill .................................................. 17  

3. **Loading and saving a poster** ..................................................................................... 19  

4. **Text onto the poster** .................................................................................................. 22  
   4.1 Text in a Text Box ....................................................................................................... 22  
   4.2 Formatting the font ...................................................................................................... 23  
   4.3 Formatting the paragraph ........................................................................................... 25  
   4.4 Formatting the Text Box itself .................................................................................... 29  
   4.5 Useful stuff ................................................................................................................ 30  
      4.5.1 Format Painter ...................................................................................................... 30  
      4.5.2 WordArt ............................................................................................................... 31  
      4.5.3 SmartArt .............................................................................................................. 32  

5. **Shapes** ......................................................................................................................... 36  

6. **Inserting Images** ....................................................................................................... 40  

7. **Putting Charts on the poster** ................................................................................... 42  
   7.1 Start from scratch. ........................................................................................................ 42
7.2 Import from existing excel files

8 Inserting tables

9 Aligning objects

10 Prepare for printing

10.1 PDF

10.1.1 Office2007

10.1.2 Other PDF converters

10.2 Transferring files

10.2.1 Transfer your file using FTP / Windows explorer

10.2.2 Transfer your file using WS_FTP

10.3 Poster Pickup
1 Introduction
This document shows how to get started in producing (eye catching) research posters using PowerPoint2007, it will cover the following topics

- how to insert to set up a basic layout
- how to insert text
- how to insert pictures
- how to insert charts
- etc.

Although PowerPoint is presentation software and it is not initially designed for producing posters, it can do a pretty nice job. PowerPoint is convenient to use for producing posters:

- No access to any special software is needed: most people have PowerPoint already installed.
- No need to learn to use a new program, most people already know how to use it.
- PowerPoint works well with other Office2007 software

PowerPoint has however its limitations; i.e. if you want special graphical effects or produce very large posters (larger than 142 cm) you will get into trouble, but it can do all the basics without too much trouble.

The procedure below describes the necessary steps to take, to produce a poster.

Procedure:

1. With your ideas in mind, make a sketch on paper:
   - Boxes for images/charts/tables
   - Boxes for text

2. Collect all materials to be used, get all the materials carefully prepared. Try to gather all the material on 1 place: (single cd or directory on a harddisk):
   - Poster Guidelines from the Conference: Size limitations, Format (Portrait or Landscape), etc.
   - Text: Your text can be typed in a word processing program such as Word and imported into PowerPoint. It is however much better to type the text directly into PowerPoint, rather than importing it. Text will include some or all of the following: Title, Authors, Abstract, Introduction, Methods, Data Collection, Results, Conclusions, References, Acknowledgment.
   - Graphics: Charts, graphs, logos, pictures, drawings. Graphics can be created in many different programs and imported into PowerPoint. Photos and slides can be scanned and saved as files.
3. **Start PowerPoint** (chapter 2)
   - Get the correct **Page Setup** (work with the final dimensions, not on A4!)
   - Enter width and height and choose orientation
   - Setup ruler and guides
   - Save early, save often, save several copies (chapter 3)

4. **Add text** (chapter 4)
   - Type the text (or insert text from a file)
   - Place it where you want it
   - Adjust to the proper font size

5. **Add the graphics**
   - Insert graphical objects (SmartArt, Shapes, etc.) (chapter 5)
     - Avoid getting too busy
     - If the graphic does not add any value, do not use it.
   - Insert images (chapter 6)
     - From file, from your storage media
     - Size images as needed, the quality will determine how large they can get
   - Insert charts (chapter 7)
   - Insert tables (chapter 8)
   - Get everything aligned (chapter 9)

6. **Prepare for printing** (chapter 10)
   - Create a PDF of your poster, check the quality of the PDF file (open it at 100% size)
   - Have someone else to review the poster
2 Setting up your PowerPoint Environment

This chapter will is intended to be a guide in setting up the correct environment for getting started. It is very important to follow these guidelines to get a comfortable start. Once the environment is set, the initial file can be saved and used as a template for later use.

2.1 Get a maximal screen area

Start with cleaning up your PowerPoint desktop, you will only have to make 1 slide, so you can move the left panel completely to the side of the screen, repeat the same action for the bottom panel. In this way you will fully use the available screen area.

Closing (narrowing) the left pane (Tab Pane)
- Click on the splitter bar and drag all the way to the left side.
- Click the Close box in the upper-right corner of the pane (this will also close the bottom pane).

Narrowing the bottom pane (Note Pane)
- Click on the splitter bar and drag all the way to the bottom side.

2.2 Start with a blank page

It is always nice to start with no clutter on the page, so start with a blank page (remove all the placeholders if there are any )

Procedure 1:
- Select the Home tab
- Click the Layout button in the Slides group
- Select the Blank layout to remove the placeholders.
Procedure 2:
- **Right-mouse-click** on the page
- select **Layout**
- Select the **Blank** layout

Figure 3 Start with a blank page

### 2.3 Choosing the appropriate size

Before putting any text or picture onto the poster, it is **very important** to first set the dimensions of the poster. Changing the size afterwards can and will ruin the layout. It is important to setup the final dimensions.

**Tips:**

- The largest dimension allowed in Office 2007 is 142 cm, another limitation is the dimension of the paper the printing service is printing on. At the ICTS Poster Printing Service, paper roles of 90 cm width are used. This means that the largest poster that can be printed using PowerPoint is 142*90 cm large.
- It is however possible to break through the limit of 142 cm. You can produce a poster on 45cm * 90cm and this print can be enlarged on the plotter to 90 cm * 180 cm. For these special cases, contact the ICTS Poster Printing Service first. However be careful with verge large posters, keep in mind that the poster still must be easy to read by the audience.
- Check the instructions of the organizing committee to have the right dimensions. The ISO A format is commonly used in dimensioning posters. The most common size is A0 (84.1*118.9 cm). Another popular format is oversize A0 (90*125 cm), this format uses the full width of the paper role.
Figure 4 A size illustration


<table>
<thead>
<tr>
<th>Size</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0</td>
<td>841 × 1189</td>
</tr>
<tr>
<td>A1</td>
<td>594 × 841</td>
</tr>
<tr>
<td>A2</td>
<td>420 × 594</td>
</tr>
<tr>
<td>A3</td>
<td>297 × 420</td>
</tr>
<tr>
<td>A4</td>
<td>210 × 297</td>
</tr>
<tr>
<td>A5</td>
<td>148 × 210</td>
</tr>
<tr>
<td>A6</td>
<td>105 × 148</td>
</tr>
</tbody>
</table>
- Go to the Design tab on the Ribbon.
- Select Page Setup.
- The Page Setup dialog box will appear.

Figure 5 Select Page Setup in Design tab

- In the Slides sized for box select Custom.
- Enter the desired dimensions. If you need oversize A0 – put the correct dimensions in here.
  - In the Width: box enter 90 and in the Height: box enter 125.
- In the Orientation section, make sure that the correct orientation is selected (Portrait or Landscape).
- Click OK.

Figure 6 Select the appropriate dimensions

Figure 7 Set custom dimensions

After the setup of the right dimensions, the screen may look like this:
Tip:
Use the zoom tool to get a more/less detailed view. The zoom tool is located in the bottom right corner.

Use the slider to set the appropriate zoom factor.

Figure 8 Start with a blank page

Figure 9 Zoom tool
• Click on the numerical zoom factor. A new window opens
• Enter an appropriate value or select a value

![Figure 10 Numerical zoom factor](image)

2.4 Setting Ruler and Drawing Guides
For a large, complex layout, it may help to use Guides (moveable dotted lines that appear on the screen but do not print) and to view the Ruler to help arrange them precisely.

The ruler will show the dimensions on the page.

• Go to the View tab on the Ribbon
• Select Ruler and Gridlines.

![Figure 11 Set ruler](image)
Drawing guides can help in aligning objects.

- Right-click on the blank part of the slide and select Grid and Guides

![Grid and Guides dialog box](image)

**Figure 12 Select Grids and Guides**

- Select the Display drawing guides on screen option and click OK

- In this screen the spacing between the grid can also be changed

![Grid and Guides settings](image)

**Figure 13 Select drawing guides**

- A vertical and a horizontal guide are placed onto the slide

![Guides at the 0,0](image)

**Figure 14 Guides at the 0,0**
These guides can be moved to another place by simply dragging them with the mouse. Removing the guides is done by moving them outside the slide (off the screen). More guides can be placed onto the slide, starting from these basic guide lines: hold down the Ctrl key and drag a copy to another place.

The guidelines can be set to guide the layout of the poster as shown in the figure below, where 4 columns are used, together with the title area.

![Setup the layout with guidelines](image)

**Figure 15** Setup the layout with guidelines

### 2.5 Changing the background

PowerPoint offers a variety of options for backgrounds:

- Uniform color
The background of the poster should not detract from the content and careful consideration should be given to the choice of colors. The PowerPoint backgrounds are intended for projected slide presentation and are not always suitable for printing.

2.5.1 Selecting a theme

It is advisable to stick with the blank page and selecting the options yourself.

- Go to the Design tab on the Ribbon
- Move the mouse over the different predefined Themes, a preview is immediately shown.

**Figure 16 Select from Themes**
2.5.2 Another way to select a theme

- Go to the **Design** tab on the **Ribbon**
- Select the **Background Styles** list and choose from the list.
- Select a style and choose the option **Format Background** to change the default options

**OR**

- Right-click on the slide and select **Format Background**

**Figure 17** Select a background style

**Figure 18** Right-click the slide and select Format Background
2.5.3 Setting the background: uniform color (solid fill)
If possible stick with light colors.

**Solid fill** (uniform color)
- Select the **Color** option to select the color

![Format Background Options Menu](image19)

![Select a background color](image20)

2.5.4 Setting the background: Gradient fill
Using gradients can be dangerous, the printed result is not always what you should expect: banding can occur.
Gradient fill

- More options appear to get the gradient as you like
- The result of the settings is already previewed on the slide.

![Gradient settings](image1)

**Figure 21 Gradient settings**

2.5.5 Setting the background: Picture or texture fill

- Using an image as a background can be tricky, transparency is usually needed, and this transparency can be a problem while printing a poster. The result can be disappointing or the plotter can even crash on it.
- If you want to use a background image, it is better to fade the image in appropriate software (photoshop, etc.) and import the faded image as such as a background picture.
- If you use a texture, again, be careful not to overload your poster

![Picture fill](image2)

**Figure 22 Background Picture settings**

Picture fill

- A picture can be imported from file and set as a background, or you can choose from available clipart.
- Be sure that the image has a good resolution.
- Most of the times, the image has to be made transparent (use the transparency slider) to fade out the image.
Tips:

- It is recommended to use lighter colors for the background rather than black or other dark colors. There is less risk of the poster being torn and the lighter colors are easier to dry.

- It is better to use a plain color for the background. If you use a complex or dense bitmap for your background, the plot file can become rather large and, in some instances, the file is rejected by the printer.

- Once the appropriate size, orientation, background, rulers, guide lines, etc. set, the file can be saved. This file can be used as a template for further use. If logo’s are to be inserted, these can also be included (see further) and saved in the template.
3 Loading and saving a poster

If there is a template available, you can start from this template to build a poster. Load this template and the environment is already correctly set.

Click on the Office icon on the top left corner and select open,

A new window opens, letting your browse through the different files on your system. Select the correct file to open the file.

While producing a poster, regularly saving is a good practice, it keeps you away from losing precious work and time. Saving a poster works the same way as opening a poster.
Click on the Office icon on the top left corner and select Save As

A new window opens, letting you browse through the different directories on your system. Select the correct destination to save the file.

Tip:
- Try to work on the file on the same computer.
- If you have to work on different computers on the same file, try to work with the same version of PowerPoint. If not problems can occur (weird loss of layout, problems printing some parts of the poster, etc.)
• If you have to work on different PowerPoint versions, save it in the lowest version.
• If you have to distribute the file, as read-only, choose to convert the file to pdf and distribute the pdf.
  Note: Save As PDF is not installed by default, this is an add-on that you have to download, use the Help function to guide you.
• If you use special fonts, that are not installed on every computer, embed these fonts. In the SaveAs menu, select the Tools box – Save options

Figure 27 SaveAs Tools - Save Options

A new window will open, select to **Embed fonts in the file** and select to **embed all characters**.

Figure 28 Save Options - Select Embed fonts
4 Text onto the poster

4.1 Text in a Text Box
In order to put text on the poster, you need a container to put the text into: Text Box.

Text Boxes can be placed onto the slide (poster) in 2 ways:

- Select Text Box and click where the Text Box should start. While you type, the Text Box will grow larger. This is not a wanted behavior when you have a strict layout to follow.

- A better way is to fix the width of the Text Box at first. Click-and-drag the Text Box to determine the width. The height of the box can not be set in advance, this will grow when you start typing and new lines are added.
4.2 Formatting the font
The font, size, etc. can be changed by highlighting the text to be changed and then making the changes by choosing the right action (under the Home ribbon tab).

Table 1 Format Text (based upon www.uwec.edu/help/Office07/fmt-txt.htm)

<table>
<thead>
<tr>
<th>Font</th>
<th>Calibri (Body)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the font face currently used</td>
<td></td>
</tr>
<tr>
<td>NOTE: The provides a pull-down list from which the font faces can be changed.</td>
<td></td>
</tr>
</tbody>
</table>

Some suggestions:
- Stay away from exotic fonts
- Use sans-serif fonts:
  - Arial
  - Tahoma
  - Trebuchet
  - Verdana
| Font Size       | 12 | Displays the font size currently used. NOTE: The pull-down list from which the font size can be changed. Some suggestions:  
- Title: between 72-120 points and consider using a large, bold sans-serif type font  
- Subtitle (author's names and institution name), make the font size smaller than the title, between 48-80 points.  
- Section headers, (Abstract, Introduction, Methods, Results, Conclusions, etc.), make the font size approximately 50% larger than the body text, between 36-72 points. Use the same font as your title or subtitle.  
- For body text, make the font size between 24-48 points. Be sure to keep the body text font size the same throughout the entire poster.  |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase Font Size</td>
<td></td>
<td>Increases the font size by one increment.</td>
</tr>
<tr>
<td>Decrease Font Size</td>
<td></td>
<td>Decreases the font size by one increment.</td>
</tr>
<tr>
<td>Bold</td>
<td></td>
<td>Applies <strong>bold</strong> formatting.</td>
</tr>
<tr>
<td>Italic</td>
<td></td>
<td>Applies <em>italicized</em> formatting.</td>
</tr>
<tr>
<td>Underline</td>
<td></td>
<td>Applies <strong>underlined</strong> formatting. NOTE: Clicking the allows you to select a single or double underline.</td>
</tr>
<tr>
<td>Font Color</td>
<td></td>
<td>Applies color to text. NOTE: Clicking the provides a pull-down list from which the font color can be changed.</td>
</tr>
<tr>
<td>Clear All Formatting</td>
<td></td>
<td>Removes all formatting and style from the selection.</td>
</tr>
<tr>
<td>Strikethrough</td>
<td></td>
<td>Applies <strong>strikethrough</strong> formatting.</td>
</tr>
<tr>
<td>Shadow</td>
<td></td>
<td>Applies a shadow to selected text.</td>
</tr>
<tr>
<td>Character Spacing</td>
<td></td>
<td>Opens a pull-down list that formats the length of space between individual characters.</td>
</tr>
<tr>
<td>Change Case</td>
<td></td>
<td>Opens a pull-down list from which you can format the case style</td>
</tr>
</tbody>
</table>
### 4.3 Formatting the paragraph

Once the text is entered, several cosmetic changes can be applied on the text as a whole (i.e. as a paragraph). The table below gives the options.

**Table 2 Format paragraph**

<table>
<thead>
<tr>
<th>Bullets / Numbering</th>
<th>Format paragraph</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Bullets/Numbering" /></td>
<td>Using bullets makes the content more powerful, try to use them as much as possible. Numbered lists can be built the same way. NOTE: The providesthe pull-down list from which different bullet styles can be chosen.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Indenting bullets</th>
<th>Get structure/divisions in the bulleted/numbered lists by indenting</th>
</tr>
</thead>
</table>
| ![Indenting bullets](image) | • Text  
  • More text  
    — Another list  
    — With elements  
      1. Numbered list  
      2. With elements  
  • More from the same list |

**Figure 32 Bullets and Numbers example**

<table>
<thead>
<tr>
<th>Line spacing</th>
<th>Set the line spacing to be used.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Line spacing" /></td>
<td></td>
</tr>
<tr>
<td>Alignment</td>
<td><img src="image" alt="Alignment" /></td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Columns</td>
<td><img src="image" alt="Columns" /></td>
</tr>
<tr>
<td>Text Direction</td>
<td><img src="image" alt="Text Direction" /></td>
</tr>
<tr>
<td><strong>Align Text</strong></td>
<td><img src="image" alt="Align Text" /></td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------</td>
</tr>
<tr>
<td><strong>SmartArt</strong></td>
<td><img src="image" alt="Convert to SmartArt" /></td>
</tr>
</tbody>
</table>
Figure 37 SmartArt

This is a powerful option, but be careful with, test to see if it really works on your poster.
4.4 Formatting the Text Box itself

Once the text is entered in the box, the Text Box itself can be formatted (background color, shading, etc.)

**Table 3 Format the Text Box itself**

<table>
<thead>
<tr>
<th>Move Text Box</th>
<th>Select the Text Box (click in the text area), the border of the Text Box is shown, with a <strong>dashed</strong> line.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1" alt="This is a Text Box" /></td>
</tr>
</tbody>
</table>

**Figure 38 Text in Text Box**

Click on the border of the Text Box, the borderline will change into a full line, now the whole Text Box is selected

![This is a Text Box](image2)

**Figure 39 Text Box selected**

The cursor changes to the **move icon** (Cross with arrowheads). Hold on the mouse and move the Text Box. The Text Box can also be rotated: bring the cursor over the green circle to rotate the text box.

**NOTE:** You can move all the objects on the slide (poster) in the same way.

<table>
<thead>
<tr>
<th>Format Text Box</th>
<th>Select the text box. The <strong>Drawing Tools Tab</strong> appears.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image3" alt="Drawing Tools / Format" /></td>
</tr>
</tbody>
</table>

**Figure 40 Drawing Tools / Format**
4.5 Useful stuff

4.5.1 Format Painter
An easy way to make all your text look the same is to use the Format Painter tool. This tool is located on the Home Ribbon tab.
Figure 43 Format Painter

If a Text Box is formatted exactly the way it should be (font, size, color, etc.), these formatting elements can be used to format other text:

- Select a source object that has the formatting the way you want it.
- Click on the Format Painter button, the cursor will change into a paint brush.
- The object clicked on, will be formatted in the same way.

4.5.2 WordArt

However be careful with WordArt, an overdose of WordArt will turn your poster into something cheap. Use it only with the purpose of attracting the audience (ex. Title)

<table>
<thead>
<tr>
<th>Inserting WordArt text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to the Insert tab on the Ribbon</td>
</tr>
<tr>
<td>Click on the WordArt button and select the style you like</td>
</tr>
</tbody>
</table>

- A WordArt Text Box appears in the slide.
  Type the text in this box.

Figure 44 WordArt options
4.5.3 SmartArt

SmartArt provides in visuals, it is a feature to create diagrams, organization charts or flow charts.

**Inserting SmartArt**
- Go to the **Insert** tab on the **Ribbon**
- Click on the **SmartArt** button, a new window with the **SmartArt Graphics** appears

Several layout types are available, the table below (from PowerPoint 2007 Help) gives an indication what type to use in order to visualize a certain process, procedure, data, etc.
Table 4 SmartArt Layout Types and their purpose

<table>
<thead>
<tr>
<th>Layout type</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| List        | ![List Layout](image)  
Show nonsequential information. |
| Process     | ![Process Layout](image)  
Show steps in a process or timeline. |
| Cycle       | ![Cycle Layout](image)  
Show a continual process. |
| Hierarchy   | ![Hierarchy Layout](image)  
Show a decision tree. |

Create an organization chart.
<table>
<thead>
<tr>
<th>Relationship</th>
<th><img src="image" alt="Diagram" /></th>
<th>Illustrate connections.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrix</td>
<td><img src="image" alt="Diagram" /></td>
<td>Show how parts relate to a whole.</td>
</tr>
<tr>
<td>Pyramid</td>
<td><img src="image" alt="Diagram" /></td>
<td>Show proportional relationships with the largest component on the top or bottom.</td>
</tr>
</tbody>
</table>

After a specific layout has been chosen, a template will appear with an area to enter text to the left of that layout. The Text pane, provides a way to quickly enter and edit the text of a graphic. The menu bar is changed automatically such that the different elements of the SmartArt object can be edited and/or changed.
Figure 48 SmartArt object editing
5 Shapes

A poster is a visual communication tool, so graphical elements have to be used to attract the attention, to clarify the structure of the poster, etc. PowerPoint provides in a lot of graphical elements that can be pasted into the slide (poster). Besides predefined SmartArt layout objects, numerous shapes are provided by PowerPoint.

Graphics are central to your poster. Remember, a picture is worth a thousand words. Choose graphics (graphs, charts, photos, drawings) which will allow you to reduce your text to a minimum.

Add shapes

- Go to the Insert tab on the Ribbon
- Click on the Shapes button. The provides a pull-down list providing a bunch of shapes

![Shapes Diagram](image)
**Format shapes**

Select the shape. **Drawing Tools** Tab appears

Click on **Format** tab. A specific Shape Editing toolbar appears. Format the selected shape in **Shape Styles**:

- **Shape Fill** -- Changes the fill color
- **Shape Outline** -- Changes the color, width, line style of outline
- **Shape Effects** -- Applies visual effects (shadow, bevel, etc.) to the shapes

**Placing shapes**

Select the shape.

The **Drawing Tools** Tab will appear. Click on **Format** tab. Arrange the order in the **Arrange Group**:

- Bring to Front
- Send to Back
Grouping shapes

While holding the shift key, click on the objects you wish to group.

Drawing Tools tab appears. Click on Format tab.

- To group the objects: Click on Group button in Arrange Group
- To align the objects: Click on Align button in Arrange Group
- To rotate the objects: Click on Rotate button in Arrange Group

Tips:

- Be careful with effects on graphical objects. If you add soft edges to boxes or shapes, the print files can quickly become enormous, and the printer will crash on it.

- Moving graphical objects: Click onto the object. The cursor changes to the move icon (Cross with arrowheads). Hold on the mouse and move the object.
• Resizing graphical objects: Click onto the object. Position the mouse over one of the sizing handles.

![Diagram of resizing handles]

Figure 50 Resizing handles

• Click-and-drag the sizing handle away from or toward the center to enlarge/shrink the object. Some effects can be added:
  
  o To keep the center of an object in the same place, hold down CTRL while you drag the sizing handle.
  
  o To maintain the object’s proportions, hold down SHIFT while you drag the sizing handle.
  
  o To both maintain the object's proportions and keep its center in the same place, hold down both CTRL and SHIFT while you drag the sizing handle.
6 Inserting Images

Decide which images and charts you wish to include and prepare any image files first. File types that are acceptable for PowerPoint to include:

- Joint Photographic Experts Group (.jpg);
- Portable Network Graphics (.png);
- Graphics Interchange Format (.gif);
- Enhanced Metafile (.emf);
- Windows Bitmap (.bmp, .rle, .dib);
- Windows Metafile (.wmf) graphics.

For complex charts and image files, you may need to go through several stages to arrive at a file-type that PowerPoint can accept, especially for data coming from data-capturing devices linked to scientific instruments.

Tips:

- Scan images so that they will have a resolution of 200-300 dpi when scaled to the final size the image will appear on the poster. Higher resolution will not give better print quality.
- For the best quality, insert the pictures into PowerPoint and do not enlarge them.
- Do not allow imported pictures to hang over the edge of the poster or they will be cropped. Use the picture cropping tool or scale the image down proportionally.
- Pictures from web sites are low resolution. If used on a poster they will be fuzzy.

**Insert a Picture**

- Go to the **Insert** tab on the **Ribbon**
- Click on the **Picture** button.
- Navigate to wherever the pictures are stored.
Figure 52 Browse for pictures

**Edit Picture**

Select the picture. **Picture Tools** Tab appears

- The picture itself can be changed: brightness, etc. but is advisable that you do not play around to much with the PowerPoint tools; have the picture prepared before adding them to the poster.
- Resizing is possible, if needed try only to downsize.
- Adding a border to the picture can help to put some order and some emphasis into the poster.
7 Putting Charts on the poster.
Try to use as much charts, diagrams as possible. Charts make it easy for your audience to visualize trends and patterns.

7.1 Start from scratch.
A Microsoft Office Excel 2007 chart can be created directly in Microsoft Office PowerPoint 2007 by clicking the Chart button on the Ribbon and then by using the chart tools to modify or format the chart. Charts that you create in PowerPoint will be embedded in the PowerPoint presentation, and their source data is stored in an Excel worksheet that is incorporated in the PowerPoint file.

**Insert a Chart**
- Go to the Insert tab on the Ribbon and click the Chart option.

- Select the chart category you want in the left side of the dialog box.
- Select the chart type within the selected category.
- Each category has several chart variants — select the one you want. If you can’t find a type that you
want, choose the one that's closest to your requirement; you can make small changes later.

This places a dummy chart, and the datasheet with dummy data opens in Microsoft Excel. The sample chart is almost as haggard as a newborn chick, but formatting the design and data of the chart can result in a much better-looking specimen.

5. Edit the chart

You're now in chart-editing mode; three additional Chart Tools tabs appear on the Ribbon. These tabs provide plenty of chart formatting options:

- **Chart Tools Design tab**, lets you change the chart type, save chart templates, edit data, change the chart layout, and apply a chart style.

- **Chart Tools Layout tab**, lets you add and edit chart and axis titles, legend, gridlines, trendlines, error bars, and other chart paraphernalia.

- **Chart Tools Format tab**, lets you apply graphic styles to your chart, arrange and resize chart elements, and apply WordArt styles to text within the chart.

Some simple tasks that you could perform to make your chart more relevant include

- Editing the datasheet as required — the chart updates dynamically
- Formatting the fills and effects for the individual series
- Formatting the font sizes of the values and titles
- Opting to include the legend
7.2 Import from existing excel files
A lot of tables and graphics are made in Excel, incorporating them in a PowerPoint poster is a natural way of working. (based on http://grok.lsu.edu/Article.aspx?articleid=642)

Select the chart in Excel to copy to a PowerPoint presentation

![Chart in Excel](image)

Figure 53 Select the chart in Excel

Copy the chart:

- Press CTRL+C

or

- use the menu function: **Home** tab, in the **Clipboard** group, click **Copy**

Click in the PowerPoint presentation where you want to paste the copied chart.

Paste the chart:

- Press CTRL+V

or

- Use the menu function: **Home** tab, in the **Clipboard** group, click **Paste**
Beneath the chart a Paste Options icon will appear.

Click Paste Options next to the chart, and choose one of the options:

- To paste the chart with a link to its source data, click Chart (linked to Excel data).
- To paste the chart and to include access to the entire workbook in the presentation, click Excel Chart (entire workbook).
- To paste the chart as a static picture, click Paste as Picture.
- To paste the chart in its original format, click Keep Source Formatting.
- To paste the chart and format it by using the document theme that is applied to the presentation, click Use Destination Theme.
Tips:

- To paste a chart in another format, click the arrow on the Paste button,

and then click Paste Special. In the As list, select the format that you want to use.

- To paste a chart as a static picture, click any Picture or Bitmap option. Picture format generally provides better display quality than Bitmap format.

- Click Microsoft Office Graphic Object to paste a chart as a graphic object that can be edited by using the chart tools in PowerPoint. This option is not available when you are using Compatibility Mode in PowerPoint.

- Click Paste link, and then click Microsoft Office Excel Chart Object, and then to paste a chart as an embedded object that is linked to the source data of the original Excel chart so that it is updated when the chart data changes. Microsoft Office Excel Chart Object is not available when you are using Compatibility Mode in PowerPoint.
## 8 Inserting tables

Inserting a table is easy in PowerPoint: click on the Table icon, a drop-down menu will appear that allows you to:

- Insert a ready-made table based on the number of rows and columns you need
- Draw (create) a table from scratch
- Insert a table filled with data from a Microsoft Excel spreadsheet

<table>
<thead>
<tr>
<th>Method 1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to the <strong>Insert</strong> tab on the <strong>Ribbon</strong> and click the <strong>Table</strong> option</td>
<td><img src="image" alt="Figure 54 Insert Table option" /></td>
</tr>
<tr>
<td>Move the pointer to select the number of rows and columns that you want, and then click.</td>
<td><img src="image" alt="Figure 55 Select table layout graphically" /></td>
</tr>
</tbody>
</table>
Method 2

- Click **Insert Table**, a new window appears
- Enter a number in the **Number of columns** and **Number of rows** lists.

![Insert Table](image)

**Figure 56 Insert table - specify columns and rows**

Once the table structure is entered, the menu fields change (**Table Tools**), and multiple options for design and layout are presented.

Other methods:

- Draw a table from scratch: use the design and layout menu to gradually build up the table
- Insert Excel Spreadsheet: an Excel spreadsheet opens and allows you to enter the data the way you are used to do in Excel.

**Tip**

- To add text to the table cells, click a cell, and then enter the text.
- To leave the table environment after the text is entered: click outside the table.
- To add a row at the end of a table, click the last cell of the last row, and then press TAB.
9 Aligning objects

There are several ways to align objects. You can align objects relative to other objects and can also distribute them evenly (equal distances from each other) horizontally or vertically.

**Align objects**

- Select the objects you want to align; this may include text boxes, graphics, imported pictures, etc.
- On the Drawing Tools toolbar, select **Align**, and then click any one of the alignment options!
10 Prepare for printing

ICTS/LUDIT cannot afford to buy all kinds of software and have the expertise in using all this software, therefore posters have to be delivered in ps, prn or pdf format. The easiest way is to convert to pdf, in this case you can also immediately check what the result of the conversion.

10.1 PDF

10.1.1 Office2007

Office 2007 lets you convert your PowerPoint poster to PDF — optimized for online documents, printed documents, or both. Before you can convert your document to PDF format, you need to download and install the support for PDF and XPS from the Microsoft Web site (guidelines are provided on the Office Help F1)

To save a PowerPoint 2007 document as a PDF file:

- Click the Microsoft Office button, move to Save As, and click PDF Or XPS.
- Click the appropriate button for Standard optimization.
- Click Publish.

The size of the poster will be the same as the set in the page setup of the poster.

10.1.2 Other PDF converters

If you have adobe acrobat installed on your computer, or any other pdf converter, this can also be used, as shown below. Older Office releases need to have a pdf converter installed, in order to get pdf files out of the Office software.

- Adobe Acrobat is the best product, but is expensive. If you have it installed on your computer, use it to print files into pdf.
- Freeware:
  - PDFCreator (http://www.pdfforge.org/) – works with Vista
  - Pdf995 (K.U.Leuven campus licence available) – does not work with Vista

10.1.2.1 To save a PowerPoint document as a PDF file – Adobe Acrobat:

- If you have an Adobe PDF menu at the top of the PowerPoint screen, select Convert to Adobe PDF from that menu.
  Note: You will only have this menu if Adobe Professional - not Adobe Reader -- is installed on your PC).
If you DO NOT see the **Adobe PDF** menu at the top of the PowerPoint screen, try going to **File > Print** and from the printer pull-down menu, select **Adobe PDF** as the printer.

- Check the properties to see if the correct size is selected (A0, A1, etc.)
- Select the Scale to fit paper option.

**Figure 57 Convert using Adobe PDF**

Click the **OK** button.

**Figure 58 Convert to PDF using the print option**

10.1.2.2 **To save a PowerPoint document as a PDF file – PDFCreator:**

Select to print the file (ctrl-P shortcut) or **File > Print** and from the printer pull-down menu, select **PDFCreator** as the printer.
Figure 59 Use PDFCreator

- Check the properties to see if the correct size is selected (A0, A1, etc.)

Figure 60 Set the properties

- Select the Scale to fit paper option.
  - Click the OK button.
10.2 Transfering files
Poster files tend to be large and cannot be transferred by mail, therefore ftp has to be used. A server is available where you can put the files onto: \texttt{ftpserv.cc.kuleuven.be}

10.2.1 Transfer your file using FTP / Windows explorer

- Open your windows explorer and type the address of the ftpserver, put ftp:// in front! 
  \texttt{ftp://ftpserv.cc.kuleuven.be/upload/plotter} select the directory of the appropriate paper type.

![Figure 61 Transfering files using Windows Explorer](image1)

- Open another windows explorer and select the file to transfer, drag and drop this file into the appropriate folder (90g, 140g, blinkend (=glossy))

![Figure 62 Transfer the files](image2)
10.2.2 Transfer your file using WS_FTP

A Session Profile is created for every FTP transaction you initiate; i.e. you can create a profile for each system you want to transfer files to or from. Click on New to create a new Profile. For each profile, information must be supplied for the following fields.

Figure 63 Transferring files using WS_FTP

Session Profile Fields for transferring files to the upload at LUDIT:

- **Profile Name**: Any name you choose for the session (LUDIT-upload)
- **Host Name**: Address of the ftp server (ftpserv.cc.kuleuven.be)
- **Host Type**: Platform of the ftp server (leave on Automatic detect)
- **User Id**: Use Anonymous
- **Password**: Use your full email address
- **Account**: Leave blank

On the left side of the screen (Local System) you see your PC. The upper scrolling window [1] represents the directories accessible to you. The lower scrolling window [2] shows the files within the selected directory.

Click on a name in the upper window and that directory will be opened. By clicking on the two dots (..) at the top of the lower window, you can navigate up one directory level on the local system. By clicking on [-a-], you can navigate to your A: drive.
On the right side of the screen (Remote Site) [3] you see the remote system, or the ftp site, you are connected with. The upper window [4] represents accessible directories. The lower window shows the files in that directory.

By clicking on the two dots (..) at the top of the directory scrolling window, you can navigate up one directory level on the remote system.

10.3 Poster Pickup
After printing, posters can be collected at ICTS/Ludit:

- Room 00.22
- Willem De Croylaan 52a, Heverlee
appropriate size, 7  
dimension, 7  
background, 13  
maximal screen area, 6  
solid fill, 16  
paragraph, 25  
blank page, 6  
ruler, 11  
chart, 41  
SmartArt, 31  
dimension, 7  
Text Box, 22  
setup, 9  
Tip  
file  
format, 28  
embed fonts, 21  
theme, 14  
open, 19  
background, 18  
save, 19  
dimensions, 7  
save as pdf, 21  
graphical objects, 37  
font, 23  
images, 39  
Format Painter, 29  
save, 20  
guides, 12  
table, 47  
images, 39  
ISO Asize dimensions, 8  
zoom tool, 10  
largest dimension  
WordArt, 30